
Q.1 Which country hosted the 2023 Men's Hockey World Cup?

Ans 1. Pakistan

2. China

3. Germany

4. India

Q.2 K is the husband of S. B is the sister of T. Q is the daughter of E. T is the brother of E. S
is the mother of B. How is T related to K?

Ans 1. Brother

2. Father

3. Son

4. Daughter

Q.3 If 15th and 28th terms of an A.P. be 208 and 416 respectively, then its 49th term is:

Ans 1. 755

2. 749

3. 752

4. 751

Q.4 The full form of DDR SDRAM is ______________.

Ans 1. Double Data Rate Systematic Dynamic Random Access Memory

2. Dynamic Data Rate Systematic Dynamic Random Access Memory

3. Double Data Rate Synchronous Dynamic Random Access Memory

4. Data Dynamic Rate Synchronous Dynamic Random Access Memory

Q.5 Two parallel current-carrying conductors attract each other with a force of 3 N when
placed 2 cm apart. The currents in both conductors are initially the same, and the
length of the conductors is constant. If the currents in both conductors are doubled
and the distance between them is halved, what will be the new force?

Ans 1. 96 N

2. 24 N

3. 12 N

4. 48 N
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Q.6 A tower stands vertically on the ground. From a point on the ground, 30 m away from
the foot of the tower, the angle of elevation of the top of the tower is 30°. What is the
height (in metres) of the tower?

Ans
1. 

2. 

3. 

4. 

Q.7 Which of the following orders is correct for the doping level in transistors?

Ans 1. Emitter < base < collector

2. Base < emitter < collector

3. Collector < base < emitter

4. Base < collector < emitter

Q.8 The first and last terms of an A.P. are 20 and 55. If the sum of its terms is 600, then the
number of terms will be?

Ans 1. 15

2. 16

3. 17

4. 14

Q.9 Which of the following statements is correct about a transistor?

Ans 1. Emitter region is much thinner as compared to base and collector.

2. All the three regions emitter, base and collector have the same size.

3. Collector region is much thinner as compared to emitter and base.

4. Base region is much thinner as compared to emitter and collector.

Q.10 What will come in the place of the question mark ‘(?)’ in the following equation, if ‘+’
and ‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

15 × 5 ÷ 7 − 8 + 9 = ?

Ans 1. 17

2. 20

3. 18

4. 19

Q.11 Which of the following represents the applications used primarily for messaging and
communication?

Ans 1. Gmail and Firefox

2. WhatsApp and Telegram

3. Safari and MS Word

4. Telegram and Safari

Q.12 Select the most appropriate options to fill in the blanks.
L.V.D.T. shows ____ hysteresis and hence repeatability is ____ under all conditions.

Ans 1. high; excellent

2. low; excellent

3. low; bad

4. high; bad
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Q.13 Which type of virus is designed to attach itself to documents and spread through
macros in programs like Microsoft Word or Excel?

Ans 1. Polymorphic Virus

2. Network Virus

3. Resident Virus

4. Macro Virus

Q.14 In the following number-pairs, the second number is obtained by applying certain
mathematical operations to the first number. Which numbers should replace X and Y so
that the pattern followed by the two numbers on the left side of :: is same as that on the
right side of ::?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

X : 40 :: 60 : Y

Ans 1. X=32, Y=70

2. X=36, Y=68

3. X=32, Y=75

4. X=30, Y=75

Q.15 In the interim budget of the union government, what budget has been allocated for
Samagra Shiksha Abhiyan for the Financial Year 2024-25?

Ans 1. ₹47,500 crore

2. ₹53,500 crore

3. ₹40,200 crore

4. ₹37,500 crore

Q.16 If an event has odds in favour 4 : 5, then the probability that the event will NOT occur is:

Ans
1. 

2. 

3. 

4. 

Q.17 If the points A(1, 2), B(4, 3), C(1, 0) and D(k, -1) are the vertices of a parallelogram then,
the value of k is :

Ans 1. 2

2. 1

3. -1

4. -2
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Q.18 In the following number-pairs, the second number is obtained by applying certain
mathematical operations to the first number. Which numbers should replace X and Y so
that the pattern followed by the two numbers on the left side of :: is same as that on the
right side of ::?
(NOTE : Operations should be performed on the whole numbers, without breaking
down the numbers into its constituent digits. E.g. 13 – Operations on 13 such as adding
/subtracting /multiplying etc. to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)
X : 35 :: 8 : Y

Ans 1. X = 10 , Y = 20   

2. X = 7 , Y = 48   

3. X = 3 , Y = 74  

4. X = 6 , Y = 68   

Q.19 What should come in place of the question mark (?) in the given series?

1023 1024 1027 1032 1039 ?

Ans 1. 1046

2. 1048

3. 1045

4. 1047

Q.20    Read the given statements and conclusions carefully. You have to take the given
statements to be true even if they seem to be at variance from commonly known facts.
You have to decide which conclusion/s logically follow/s from the given statements.

Statements:
All parks are grounds.
Some grounds are museums.
No museum is a theatre.

Conclusions:
(I) All museums are parks.
(II) No ground is a theatre.

Ans 1. Only conclusion I follows.

2. Neither conclusion I nor II follows.

3. Only conclusion II follows.

4. Both conclusions I and II follow.

Q.21 Which of the following is true according to the work-energy theorem?

Ans 1. Work done on an object can either increase or decrease its kinetic energy

2. The work done on an object is always positive

3. Work done on an object always increases its kinetic energy

4. Kinetic energy is always conserved

Q.22 The direction of magnetic field lines inside a bar magnet is _____.

Ans 1. from North Pole to South Pole

2. perpendicular to the magnetic axis

3. random

4. from South Pole to North Pole

Q.23 The work done by non-conservative forces in a closed loop is ______.

Ans 1. always zero

2. independent of the path

3. dependent on the path

4. negative
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Q.24 Which of the following is NOT an example of application software?

Ans 1. Windows Vista

2. Google Chrome

3. Adobe Photoshop

4. WhatsApp

Q.25 In this question, a question is followed by two statements numbered (I) and (II). You
have to decide whether the data provided in the statements are sufficient to answer the
question. Read both the statements and decide the appropriate answer.
Question: Five people V, W, X, Y and Z are sitting in a straight row, facing north. Who
sits to the immediate left of Z?
Statement (I): Both V and X are immediate neighbours of Y. V sits at one of the extreme
ends of the row.
Statement (II): Z sits to the immediate left of W. W sits at one of the extreme ends of the
row.

Ans 1. Data in either statement I alone or statement II alone are sufficient to answer the question.

2. Data in statement II alone is sufficient to answer the question while data in statement I is not.

3. Data in statements I and II together are sufficient to answer the question.

4. Data in statement I alone is sufficient to answer the question while data in statement II is not.

Q.26 In the equation x = A cos(ωt+ϕ), where x is displacement, ω is angular frequency, and ϕ
is phase angle, the equation is dimensionally consistent if __________.

Ans 1. ωt has dimensions of length and ϕ is dimensionless

2. A has dimensions of time and ωt has dimensions of frequency

3. A has dimensions of length and ωt is dimensionless

4. A has dimensions of length and ϕ has dimensions of time

Q.27

Ans 1. 

2. 

3. 

4. 

Q.28 In which of the following cases will there be NO induced EMF in a coil?

Ans 1. The magnetic flux through the coil is changing.

2. The coil is moved parallel to the magnetic field lines.

3. The coil is rotated in a magnetic field.

4. The coil is moved perpendicular to the magnetic field lines.

Q.29 The mode and median of a data is 87.5 and 86, respectively. What is the mean of the
data? (Use empirical formula.)

Ans 1. 85.2

2. 85.4

3. 84.2

4. 87.1
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Q.30 Who inaugurated India’s first off-grid Green Hydrogen Plant in the Stainless Steel
Sector at Hisar in March 2024?

Ans 1. HD Kumaraswamy

2. Amit Shah

3. Bhupathiraju Srinivasa Varma

4. Jyotiraditya M Scindia

Q.31 When a conductor moves through a magnetic field, an induced current is produced.
The direction of the induced current is determined by ___________.

Ans 1. Lenz’s Law

2. Faraday’s Law

3. Coulomb's Law

4. Ampere’s Law

Q.32 If the quadratic equation x2 − 4ax + (b + 1) = 0, where a and b are real constants, has no
real roots, then:

Ans 1. b < (a + 1)(a − 1)

2. b < (2a + 1)(2a − 1)

3. b > (2a + 1)(2a − 1)

4. b > (a + 1)(a − 1)

Q.33 A car manufacturing company is sponsoring a basketball match by painting its logo on
the basketball at the rate of ₹3/ cm2 . There are two identical basketballs of diameter 14
cm which are to be painted. What will be the total cost (in ₹) of painting the balls for the
company?

Ans 1. 1848

2. 3586

3. 4928

4. 3696

Q.34 A statement is given followed by two arguments. Decide which of the arguments is/are
strong with respect to the statement.
Statement:
The Government of country B has urged its citizens to invest in rain water harvesting
and avail subsidies in doing so.
Arguments:
I. Ground water resources have been continuously depleting in country B.
II. Country B experiences heavy rainfall during the monsoon season leading to flooding
in many low-lying areas.

Ans 1. Both I and II weaken the statement. 

2. Both I and II strengthen the statement.  

3. II weakens while I strengthens the statement.  

4. I weakens while II strengthens the statement. 

Q.35 Which element is typically found at the bottom left of the desktop in the Windows OS?

Ans 1. Notification Center

2. Start Menu

3. Recycle Bin

4. Quick Access Toolbar

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.36 Select the most appropriate options to fill in the blanks.
Microprocessor 8085 has ________ address line, hence it can access ________ of the
memory.

Ans 1. 16; 32 kilobytes

2. 8; 32 kilobytes

3. 8; 64 kilobytes

4. 16; 64 kilobytes

Q.37 Dead time is the time required by an instrument to _____ to respond to change in _____
quantity.

Ans 1. stop; output

2. begin; output

3. begin; input

4. stop; input

Q.38 What is India’s average annual HDI growth for the period 1990-2019?

Ans 1. 1.42

2. 1.44

3. 1.21

4. 1.58

Q.39 LCDs typically have response times in the range of _____ to _____, whereas LEDs are
available with response times below _____.

Ans 1. 100 ms; 300 ms; 1000 ns

2. 10 ms; 30 ms; 10 ns

3. 10 ms; 30 ms; 100 ns

4. 100 ms; 300 ms; 100 ns

Q.40 64 identical small spheres are cast from a sphere of radius 12 cm, with the total volume
of the small spheres being equal to the volume of the larger sphere. The diameter (in
cm) of each of the small spheres is:

Ans 1. 6

2. 11

3. 5

4. 3

Q.41 In which of the following devices are eddy currents utilised beneficially?

Ans 1. Electric heaters

2. Electric motors

3. Transformer cores

4. Induction furnaces

Q.42 What does the 'This PC' icon on a Windows desktop represent?

Ans 1. An application launcher

2. A file that stores system updates

3. Access to drives, files and system properties

4. A shortcut to the Control Panel
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Q.43 Which view is primarily used to run a slide show in MS-PowerPoint?

Ans 1. Notes Page View

2. Normal View

3. Slide Show View

4. Slide Sorter View

Q.44

Ans 1. 

2. 

3. 

4. 

Q.45 Study the given bar graph and answer the question that follows.

The given bar graph shows the number of students from different schools enrolled in
different classes. Which class has the maximum students from school C?

Ans 1. German

2. Italian

3. Japanese

4. French

Q.46 The product of (x - 9) and (x + 8) is:

Ans 1. x2 + x + 72

2. x2 - x - 72

3. x2 + 72

4. x2 + 2x - 72

Q.47 How do you sort data in Microsoft (MS) Excel in ascending or descending order?

Ans 1. By selecting 'Sort' from the Format menu

2. By selecting the data range, then choosing 'Sort' from the Data menu and specifying the sorting criteria and order

3. By right-clicking on the data and selecting 'Sort' from the context menu

4. By clicking on the 'Sort' button in the toolbar
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Q.48 The band gap between conduction and valence band in metals is:

Ans 1. 0 eV

2. 6.0 eV

3. 0.7 eV

4. 1.1 eV

Q.49 Refer to the following letter, number and symbol series and answer the question that
follows.

(Left) + 2 $ Q = Y L A S S X L / % 9 T \ = X H 6 ? (Right)

How many such numbers are there that are immediately preceded by a symbol and
immediately followed by a letter?

Ans 1. Three

2. One

3. Two

4. Four

Q.50 The coordinates of the centroid of the triangle ABC whose vertices are A(-5, 7), B(-4, -5)
and C(4, 5), is

Ans
1. 

2. 

3. 

4. 

Q.51 The deflection sensitivity (s) of a CRT (cathode ray tube) is defined as:
(where D is deflection of the screen and E is defection voltage)

Ans
1. 

2. 

3. 

4. 

Q.52 D, E, F, G, H, I, and J, each has an exam on a different day of a week starting from
Monday and ending on Sunday of the same week.
E has the exam on Friday. Only one person has the exam between E and D. J has the
exam on the day immediately after E. H has the exam on the day immediately after D.
Only two people have exams between H and G. F has the exam on the day immediately
before D. I does not have the exam on Monday.
How many people have exams between J and F?

Ans 1. Five

2. Four

3. Three

4. Two

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.53 In an isosceles triangle, the vertex angle measures 76°. What is the measure of each of
the base angles?

Ans 1. 32° and 49°

2. 55° and 49°

3. 52° and 52°

4. 43° and 62°

Q.54 You can save your MS-PowerPoint presentation in the newest format _____, or as an
MS-PowerPoint 97-2003 Presentation _____.

Ans 1. (.docx), (.doc)

2. (.pptx), (.ppt)

3. (.odp), (.ppt)

4. (.ppt), (.pptx)

Q.55

Ans 1. 28

2. 27

3. 37

4. 38

Q.56 Which of the following factors does NOT affect the strength of the magnetic field inside
a solenoid?

Ans 1. Number of turns per unit length

2. Length of the solenoid

3. Presence of a magnetic core

4. Current flowing through the solenoid

Q.57 Which of the following terms will replace the question mark (?) in the given series to
make it logically complete?
LQ13 MR20 NS27 OT34 ?

Ans 1. PV41

2. PV42

3. PU42

4. PU41

Q.58 How can you quickly change the case of selected text in MS Word?

Ans 1. Use the keyboard shortcut ‘Shift + F3’

2. Right-click the selected text and choose ‘Font’

3. Change it manually by typing the text again

4. Go to the ‘Home’ tab and click on ‘Change Case’

Q.59 Which of the following is the standard method to print a web page using most modern
web browsers?

Ans 1. Pressing Ctrl + P (Windows) or Cmd + P (Mac)

2. Right-clicking and selecting 'Save As'

3. Pressing F12

4. Pressing Ctrl + S (Windows) or Cmd + S (Mac)
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Q.60

Ans
1. 

2. 

3. 

4. 

Q.61 Which of the following statements is true regarding the factors affecting the resistance
of a conductor?

Ans 1. Resistance increases with an increase in the temperature for most metals.

2. Resistance is independent of the conductor's length.

3. Resistance is inversely proportional to the resistivity of the material.

4. Resistance is directly proportional to the cross-sectional area of the conductor.

Q.62 Which of the following Articles of the Indian Constitution states that it is the duty of the
State to raise the level of nutrition and the standard of living of its people and to
improve public health?

Ans 1. Article 42

2. Article 44

3. Article 51

4. Article 47

Q.63 In a survey of 350 students in a college, 150 students were found to be taking tea and
225 taking coffee, 100 were taking both tea and coffee. Find how many students were
taking neither tea nor coffee?

Ans 1. 85

2. 65

3. 75

4. 55

Q.64 Which of the following are copper deposits fields in India?

Ans 1. Singareni and Singrauli

2. Pench and Kanhan

3. Jharia and Raniganj

4. Khetri and Kolihan

Q.65 If A = { 3, 5, 7, 9, 11 }, B = {7, 9, 11, 13}, C = {11, 13, 15}, find A ∩ (B ∪ C).

Ans 1. {7, 9, 11}

2. {3, 5, 7, 9, 11}

3. {5, 7, 9, 11}

4. {3, 7, 9, 11}
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Q.66 Intel 8051 microcontroller is a/an:

Ans 1. 64-bit microcontroller

2. 16-bit microcontroller

3. 24-bit microcontroller

4. 8-bit microcontroller

Q.67 ெகா�க்கப்பட்ட அ�க்ைககள் மற்�ம் ���கைள கவனமாக ப�த்�,
ெகா�க்கப்பட்ட ���களில் எ� அ�க்ைககைள �ன்பற்��ற�
என்பைத ��� ெசய்�ங்கள்.
அ�க்ைககள்:
'இன்� ஒ� �ரகாசமான �ரிய ஒளி ��ந்த நாள், எனேவ கடற்கைர�ல்
காைல உணைவ சாப்�ட்��ட்� �ன்னர் நீங்கள் அைனவ�ம் பாரக்்க
��ம்�ய அ�ங்காட்�யகத்�ற்�ச ்ெசல்ேவாம்' - ஒ� தந்ைத தன�
�ழந்ைதகளிடம் ��னார்.
���கள்:
(i) அைனத்� ��ம்ப �ற்�லாக்க�ம் �ரகாசமான �ரிய ஒளி ��ந்த
நாட்களில் மட்�ேம �ட்ட�டப்பட ேவண்�ம்.
(ii) அ��யல் அ�ங்காட்�யகங்கள் �ழந்ைதகளின் கல்�க்� �க�ம்
பயனளிப்பைவ அேத சமயம் ேவ�க்ைகயானைவ�ம் ஆ�ம்.

Ans 1. ��� (I) அல்ல� (II) ஆ�ய எ��ம் �ன்பற்ற�ல்ைல

2. ��� (II) மட�்ம் �ன்பற்��ற�

3. ��� (I) மட�்ம் �ன்பற்��ற�

4. ���கள் (I) மற்�ம் (II) இரண்�ம் �ன்பற்��ன்றன

Q.68 A thermometer consistently reads 2°C higher than the actual temperature. This
thermometer is _____________.

Ans 1. precise but not accurate

2. neither accurate nor precise

3. accurate but not precise

4. both accurate and precise

Q.69 What is the name of the service unveiled by Reliance Jio Infocomm Limited, India's first
satellite-based gigabit broadband service, in October 2023?

Ans 1. Jio Fiber Network

2. Digital Subscriber Lines

3. Jio Space Fiber

4. Mobile Broadband

Q.70 What does the 'IF' function do in MS-Excel?

Ans 1. It sorts the data.

2. It sums up the data.

3. It checks a condition and returns one value if true and another if false.

4. It filters the data.

Q.71 The induced potential difference in a conductor is directly proportional to _____.

Ans 1. the area of the conductor

2. the resistance of the conductor

3. the speed of the conductor's motion through the magnetic field

4. the temperature of the conductor
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Q.72 What will happen to the power consumed by a device if the current flowing through it is
doubled while the resistance remains constant?

Ans 1. Power will double.

2. Power will quadruple.

3. Power will remain the same.

4. Power will decrease.

Q.73 Which of the following is true for resistors in parallel?

Ans 1. The equivalent resistance is greater than the smallest resistance.

2. The equivalent resistance is the sum of all resistances.

3. They have the same current.

4. They have the same voltage.

Q.74 Three resistors have the following magnitudes.

R1 = 30 Ω ± 5%, R2 = 60Ω ± 5%, R3 = 50Ω ± 5%

Determine the magnitude of limiting resultant resistance when all three resistances are
connected in series.

Ans 1. 140 ± 7Ω

2. 140 ± 15Ω

3. 27.27 ± 15Ω

4. 27.27 ± 7Ω

Q.75 When printing a web page, what is the 'Margins' setting control?

Ans 1. The space between the content and the edges of the printed page

2. The number of pages the content will span

3. The color scheme of the web page

4. The font size of the content

Q.76 What is term used to refer the ‘exports to foreigners’ in the circular flow of income
diagram?

Ans 1. injection

2. Investment

3. expenditure

4. leakage

Q.77 A device operates with a current of 2 A and a voltage of 12 V. What is the energy
consumed in 5 minutes?

Ans 1. 1440 J

2. 7200 J

3. 14400 J

4. 720 J

Q.78 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which pair DOES NOT belong to that
group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster pair.)

Ans 1. OH-MT

2. SL-RX

3. RK-QW

4. LE-KQ
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Q.79 The Deflection Factor (G) of a CRT (where s is the defection sensitivity) is defined as:

Ans
1. G = 

2. G = 

3. G = s2

4. G = s

Q.80

Ans
1. 

2. 

3. 

4. 

Q.81 Eddy currents are produced in a conductor when it is subjected to ___________.

Ans 1. a changing magnetic field

2. a uniform magnetic field

3. a constant magnetic field

4. an electrostatic field

Q.82 There are two types of links supported in the NTFS file system, ________________.

Ans 1. soft links and direct linking

2. hard links and direct linking

3. hard links and junctions

4. soft links and junctions

Q.83 Which of the following keyboard shortcuts is NOT used in MS Word 2019 to manipulate
the formatting of selected text?

Ans 1. Ctrl + U

2. Ctrl + S

3. Ctrl + I

4. Ctrl + B

Q.84 What happens when you click the 'Font Color' button in the Home tab of MS-Word?

Ans 1. It changes the font color of the selected text to the default color.

2. It changes the background color of the selected text.

3. It opens the Font dialog box.

4. It opens a drop-down list of colors to choose from.
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Q.85 The SI unit for measuring very large distances, such as astronomical distances, is
______________.

Ans 1. metre

2. kilometre

3. astronomical unit

4. light-year

Q.86 Which of the following methods is used to create a custom series in MS-Excel?

Ans 1. Using Data Validation

2. Using Conditional Formatting

3. Using Sort & Filter

4. Using the Fill Handle and dragging

Q.87 �ன்வ�வனவற்�ல் தரம்சாஸ்�ரம் எ�?

Ans 1. ேமக�தம்

2. பகவத் �ைத

3. ச�ந்தலா

4. அரத்்தசாஸ்�ரம்

Q.88

Ans 1. -3

2. -5

3. -4

4. -2

Q.89 Which of the following statements is FALSE with respect to Style Set in Outlook for
writing an email?

Ans 1. You can change the colors or fonts that are used in a Style Set by clicking Change Styles in the Styles group, and then
clicking Colors or Fonts.

2. If you changed the styles in a message and the styles are not updating the way you expected, click the Styles Dialog Box
Launcher, and then click the Style Inspector button (located at the bottom of the pane) to find out whether text was manually
formatted instead of formatted by using styles.

3. You can see how a Quick Style set will look in a message by pointing to a Style Set without clicking it.

4. After you select a Style, you can see a list of the style sets available within the styles. In the Styles group, click the Styles
Dialog Box Launcher .

Q.90 Which type of virus attaches itself to executable files and spreads when the file is run?

Ans 1. Macro Virus

2. Polymorphic Virus

3. Boot Sector Virus

4. File Infector Virus

Q.91 Which of the following is NOT a disadvantage of LAN?

Ans 1. It can face security issues if the central server is not properly secured.

2. It has high data transmission rates.

3. It has a high initial setup cost.

4. It restricts the size of the network.
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Q.92 Select the most appropriate option to fill in the blank.
Intel 8051 microcontroller has _________ internal RAM.

Ans 1. 64-byte

2. 128-byte

3. 32-byte

4. 16-byte

Q.93 A particle starts from rest and accelerates uniformly along a straight line with
acceleration a. After a time t, its velocity is v. If the particle continues to accelerate for
the next 2t, what will be the ratio of the distance travelled in the first t seconds to that in
the next 2t seconds?

Ans 1. 1 : 8

2. 1 : 12

3. 1 : 6

4. 1 : 4

Q.94 Dimensional consistency of an equation implies that _______.

Ans 1. the equation is correct in all circumstances

2. the equation respects the principles of homogeneity of dimensions

3. the physical quantities involved are related correctly

4. the units of measurement can be easily converted

Q.95 Which property of the material of a conductor determines its resistivity?

Ans 1. Melting point

2. Electrical conductivity

3. Temperature coefficient

4. Density

Q.96 The work done by a variable force is given by which of the following?

Ans 1. W=F⋅cosθ

2. W=F⋅d

3. W=∫F dx

4. 

Q.97 In which year was Pitt’s India Act passed by the British Parliament?

Ans 1. 1784

2. 1857

3. 1774

4. 1853

Q.98 In the following triad, each group of letters is related to the subsequent one following a
certain logic. Select from the given options, the one that follows the same logic.

LIVE - IVLE - EVIL
REST - ESRT - TSER

Ans 1. WIND - INWD - INDW

2. WEST - WSET - TSEW

3. MUTE - UTME - ETUM

4. YORK - OYRK - KORY
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Q.99 The brightness of LED depends upon _____; when source voltage is much _____
than diode voltage, then the brightness of the LED is approximately constant.

Ans 1. temperature; smaller

2. temperature; greater

3. current; greater

4. current; smaller

Q.100 Select the most appropriate options to fill in the blanks.
_________ are used in load cells and proving rings to measure _______ produced.

Ans 1. Linear Variable Differential Transformer (LVDT); strain by the force

2. Strain gauges; force by the strain

3. Capacitive transducers; force by the strain

4. Piezoelectric transducers; strain by the force
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